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1 e/pop 3.1 Admin Guide

1.1 Welcome

Welcome to e/pop™, a real-time communication application from WiredRed™ Software.  e/pop
extends an organization's ability to communicate by offering features such as real-time status, pop-up
messages, chat, remote control and Application Sharing.

e/pop operates as a scalable client/server application and can support thousands of users in a
distributed model.  Using an e/pop server you can connect users across networks, the Internet and
between businesses.  Working with your company network, e/pop server is the ultimate application
for communication throughout any organization.

Real-time communication is much more than instant messaging.  A complete solution for
communications requires security controls and the centralized management of users, groups and
profile lists.  The e/pop server architecture takes into account that most businesses will want to
communicate easily with coworkers, while network managers will want to centrally control all feature
access, security, group and user details.

With multiple distributed e/pop servers you can communicate across diverse geographic boundaries
in real-time using all the features provided by the e/pop client application.

Who Should Read this Guide?
The intended audience for this guide is the administrator at the server level.

Releases Covered in this Guide
This guide covers Release 3.1 of Wired Red's e/pop server software and the e/pop client
configuration utility call the e/pop Control Panel.

What You Should Know
This guide assumes you have:

·  Familiarity with Graphical User Interfaces (GUIs)

·  An understanding of the Windows Operating System

·  Familiarity with network configurations and protocols
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1.2 Benefits of Using e/pop

A brief description of the benefits you will enjoy using the e/pop server is listed below.

· Improve productivity - Improve timeliness and efficiency of communication.

·  Easy to Install - Maximize the deployed network investment of broadband networks and high
performance backbones.

· Enhance Communications - Remove delays inherent with most forms of office communication.

· Improved Interaction - Establish real-time interaction with employees, partners, vendors and
customers for true instant collaboration.

· Improve service and support - Leverage high performance remote control and network features
to provide technical support throughout the organization.

· Simple management - Comprehensive management tools for easy administration by the network
manager.

· Leverage deployed directories - Utilize existing NetWare or Microsoft deployed directories to
interact with live network groups and users.
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1.3 What's New?

WiredRed's e/pop 3.1 server platform is the most comprehensive real-time communication product
for collaboration.  The new version is delivered with new and improved features and functionality.

e/pop 3.1 contains the tools that you need to manage all the aspects of real-time communication in
your company; combined with the tools necessary to centrally administer and secure e/pop
communications for the network manager, including:

·  Instant messaging (Pop up style)

· Status

· Groups

· Profiles (Server side buddy lists)

· Chat (Private and Public)

· Remote control

· Application sharing

· Voice conferencing
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1.4 e/pop IM server

Each of the following provides a brief description of the new enhancements delivered with the
e/pop 3.1 Server.

· Send popup messages to offline users - e/pop's new server allows messages to be composed
and sent to users while they are offline. The server handles message routing and interconnecting
to multiple distributed servers over wide area networks

· Centralized group management - Now you can create groups on your server and organize all
your users centrally

· Control a users buddy list on the server via profile - Profiles provide complete control over the
presentation of users and groups to the e/pop users on your network. You can think of profiles as
server side buddy list.

· Centralized Public and Private chat rooms - Create permanent chat rooms that reside on the
server and can be joined at any time

· Scalable architecture that can connect e/pop over enterprise WANs  - e/pop's real-time routing
allows servers to connect over a wide area network for enterprise scale communications.

· Manage all your e/pop servers from one location - e/pop's new console application allows you
to connect and manage any of your e/pop servers from one location anywhere in the world.

· Terminal Server for NT/2000/2003 and Citrix Winframe support - With the e/pop server, users
can communicate within Terminal Server and Citrix Winframe virtual sessions.

· Advanced compression and encryption for maximum performance and security - e/pop
combines RSA digital certificates and signing, RC4, DES and the newly adopted government
standard AES for secure communications.  The security controls ensure your communications are
private over any connection.

· Servers can operate as a NT/2000 service or an application on any Windows platform - e/pop
dedicated servers can operate as a background process on Windows NT/2000/2003.

· Real-time traffic analysis of bandwidth utilization - Watch the real-time data flow through the
network from status, message, chat and other aspects of e/pop using the server console.
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1.5 e/pop IM client

The following provides a brief description of the new enhancements delivered with the e/pop 3.1
client.

· Locations - The locations feature connects clients to the  e/pop server through any type of TCP/IP
connection, from any physical location including directly over the Internet, through firewalls and
VPNs.

· Improved messaging - Provides new functionality for selecting recipients while composing or
forwarding messages.

· Improved history feature - The macro, shortcut and message history features have been
completely redesigned for improved performance and usability.

· New Routing Architecture - e/pop server uses WiredRed's new real-time routing architecture.

· Voice conferencing - Provides both person-to-person voice chats and group voice conferences
over a TCP/IP based network.

· Complete client/server model -  e/pop operates in a true client/server model.
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1.6 WiredRed Support

To contact support, please visit our web site at:

http://www.wiredred.com

or send e-mail to:

support@wiredred.com
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1.7 WiredRed Sales

For sales and product ordering information, please visit our web site at:

http://www.wiredred.com

or send e-mail to:

sales@wiredred.com
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2 Introduction

2.1 Basic Features

The basic administrative features and their tasks are described in this administrator's guide and
include the following:

· Installation and Deployment
· Feature controls
· Security
· Pipes
· Groups
· Users
· Profiles
· Remote administration



Introduction

e/pop Admin Guide

15Program Files

2.2 Program Files

The following files are copied to e/pop Server directory after running the essetup.exe program.

Program Files Description

EPopCon.exe e/pop Server Console (Used for administering the e/pop server)

EPopS.exe e/pop Server Service (This application runs as a service when you
install e/pop Server on Windows NT4, 2000 and XP)

EPopSA.exe e/pop Server Application (This application runs in Windows system
tray)

EPopSV.exe e/pop Server Viewer Application

EPopSWiz.exe e/pop Wizard utility

Server.hlp Help File

Server.cnt Help File Index

unins000.exe Uninstall utility

unins000.dat Uninstall Index

XSvc.exe Command line agent (Used for starting the e/pop server
application from the command line)
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3 Deployment

3.1 Introduction to deploying e/pop

Deploying e/pop is a straight forward process. As long as you understand how e/pop works, you will be
able to configure and deploy e/pop with little issues. This document discusses the configuration and
deployment process for e/pop in most environments. There are, however, exceptions where specific
issues exist which this document may not address. If you fall into that category, we encourage you to
contact WiredRed support so we can make appropreiate recommendations for deploying e/pop in your
environment.
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3.2 Summary of the deployment process

Deploying e/pop can be broken down into 8 steps.

Step 1. Prepare your network environment for e/pop.

Step 2. Install and activate the e/pop server.

Step 3. Review and configure the e/pop server to meet your company's requirements.

Step 4. Review your company's desktop software policy, user's operating behaviour and requirements.

Step 5. Draw up a plan on how you want to organize users in e/pop.

Step 6. Pre-configure the e/pop clients using the e/pop control panel.

Step 7. Distribute the e/pop client to all your users.

Step 8. Organize users on the server in groups after their accounts are created.
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3.3 Requirements

3.3.1 Overview

e/pop is a real-time communication application designed to operate on a Pentinum II 400 Mhz class
computer but a computer with a Pentium III or better processor is recommended. In addition to having
a computer that meets the recommended requirements, the network should be a 100 Mbit switched
Ethernet network or better. If you do not meet this requirements, we recommend you consult with a
WiredRed engineer so we can evaluate your environment in more detail.

3.3.2 Network requirements

Network Requirements

· TCP Port 35000 from the e/pop client to e/pop server must be unrestricted.
· No devices must intefer with the open TCP socket connections between the e/pop client and e/pop

server. These include firewalls, proxy & routers.
· The route used by client to the Servers and connections between e/pop servers over pipes must be

reliable.

e/pop is a client/server application where the client application maintains an open connection to the
e/pop server. This open connection model allows e/pop to deliver real-time information between users.
e/pop is very efficient in managing the information it places on the network but you must still ensure
there is sufficient network bandwidth and the network operates with little or no errors. For a successful
e/pop deployment, WiredRed recommends customers evaluated their network with the e/pop simulator
before proceeding with the deployment process.

Networks
You must ensure the existing network is not experiencing network issues like drop packets and
excessive collisions. A network monitoring tool will be able to provide you with this information. If you
are experiencing these issues, you must correct them prior to deploying e/pop.

Security Policies
Security policies in a corporate networks can effect e/pop communications. This include but not limited
to

· Restricted use of TCP Ports

· The use of firewalls or proxies to control incoming or out going TCP traffic

· Using ACL on a router to block incoming or out going TCP traffic

· Controlling the life of TCP socket connections

Slow WAN links
If you plan on connecting offices located in different geographical locations, you must ensure there is
sufficient bandwidth between the locations. You can get this information by using a network monitoring
tool or contacting your WAN provider for more details.

Slow WAN connections include
The various DSL connections
Cable Modems
Partial T1 - 128K, 256K, 512K
Frame Relay

WAN connection over ISDN with usage charge is not recommended because it's not cost effective.

WAN connections over Frame Relay
Companies who use a Frame Relay connection between offices must ensure the Port speed on the
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router does not exceed the guaranteed speed through the Frame cloud. Contact your provider from
information on this issue.

3.3.3 Server requirements

The e/pop server is a multi-threaded and SMP compatible server application (SMP compatible stands
for Symetric Multi-Processing. This is where an application is designed to utilize the processing power
of multiple CPUs on a computer). The overall performance of the e/pop server can be increased if
there are more CPUs adn RAM available for e/pop. The information below will guide help you in sizing
the hardware required for your e/pop server.

Note: The servers below are using Windows 2000 Server of better.

Single CPU servers (minimum requirements)
· Pentium 3 - 600 MHz w/256 MB RAM - up to 200 Users

· Pentium 3 - 800 MHz w/256 MB RAM - up to 350 users

· Pentium 3 - 1.2 GHz w/384 MB RAM - up to 500 users

· Pentium 4 - 1.8 GHz w/384 MB RAM - up to 800 users

· Pentium 4 - 2 GHz w/512 MB RAM - up to 1500 users

Dual CPU servers (minimum requirements)
· Pentium 3 - 600 MHz w/512 MB RAM - up to 600 users

· Pentium 3 - 1.2 Ghz w/512 MB RAM - up to 1200 Users

· Pentium 3 - 1.8 GHz w/1 Gig RAM - up to 2000 users

3.3.4 Client requirements

The e/pop client is designed for users to communicate with each other in real-time. These include
presence awareness, instant messaging, single or multi-user chat, application sharing, and remote
administration.

The following are minimum requirements for the e/pop client

· Pentium II 400 MHz or better

· 32 Megabytes of RAM

· 50 MB hard disk space

· Network connection
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3.4 Step 1 - Install & Activate e/pop Server

3.4.1 Overview of the e/pop Server

The e/pop server is built on top of WiredRed's real-time routing engine which has the ability to deliver
messages between users and other e/pop servers rapidly. The real-time routing capability makes
e/pop an ideal solution for many business functions such as broadcasting a message to a large
number of users over TCP and hosting many simultaneous multi-user chat sessions. Beside having
an advance real-time routing engine, the e/pop server is a true multi-threaded and Symmetric Multi
Processor application. Symmetric Multi Processor means the computer has multi CPUs in it.

To better understand the power of the e/pop server, we will describe some basic communication
processes and compare that to a real-world example.

When a user connects to an e/pop server, a sequence of events take place. First the server relays
the status of the user who just came on online to all e/pop servers connected through a real-time
virtual connection called Pipes. The status is then relayed to all users connected locally to the server.
Since the e/pop server is a multi-threaded application, it manages the entire process very efficiently
using advance thread management. Note, users running e/pop Alert and those with a restricted e/pop
profile will not receive status updates. To increase efficiency, all e/pop traffic is compress prior to
being placed on the network.

On a server with 1000 users using e/pop Basic with no e/pop profile, e/pop will uses no more then
500 Kb of bandwidth for status delivery if almost every users come online within a short interval. This
process can also be load balanced if there are other e/pop servers on the network.

An e/pop instant pop up message and real-time chat works in the exact same way. The only
difference is that messages and chat can be directed to an individual or a group and this reduces the
network traffic.

3.4.2 Installing e/pop Server

This topic describes the procedure used to install and deploy e/pop server in a corporate network. It
includes configuration settings used by the network administrators who deploys and manages the
e/pop server.

Note:  If you install the e/pop server using the setup program, you can uninstall it using the
Windows Add/Remove utility.

Installing the e/pop server software

The e/pop server runs as a service application in NT4, 2000, XP and 2003 operating systems. Below
are steps for install the e/pop server.

1. Download the e/pop server setup program - e/pop server

2. Run the setup program

3. Follow the instruction until the installation is complete

In addition to the service application the setup program installs other components related to the e/pop
server. These applications include

e/pop Console - The Console is used to administer the e/pop server.

e/pop server viewer - This application display all the real-time activity on the e/pop server such
users connecting, users disconnecting, any system errors etc.

e/pop server (tray application) - This application performs the same job as the service application,
however, this version runs in the system tray. This application is useful for troubleshooting. Also,
since this is a system tray application, you can terminate the application from the Task manager

http://www.wiredred.com/download_products.html
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whereas the service application cannot.

Updating the e/pop Server

To update an existing e/pop server to a new revision, simply install the new update over the existing
installation. During the update process only the application files are updated thereby leaving all the
other files untouched. This mean all the existing settings, groups and users will be unaffected.

Note: As part of your best practice for managing e/pop, you should update the e/pop server after
business hours to avoid disrupting the end users. However, if you have to update the server while
users are connected to the e/pop server, e/pop clients will temporarily disconnect from the server and
automatically reconnected to the server once the server becomes available.

Where to find the installation program
The e/pop server installation file is called essetup.exe. This file can be found at the following locations:

· WiredRed website (click to download the latest version)

· The e/pop CD-ROM

3.4.3 Activating e/pop

After you purchase e/pop you will receive a license file via email or on a floppy disk. The license file is
a perpetual license and is used to activated e/pop from trial mode to non-restricted mode. To activate
e/pop, you must copy the license file into the folder where you installed e/pop server, which by default
is

c:\program files\wiredred\epops

After you copy the license file into the folder, you must stop and start the e/pop server service to
activate e/pop.

Windows services menu

http://www.wiredred.com/downloads/essetup.exe
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Note: This process must be repeated on all e/pop servers on your network.

3.4.4 Starting e/pop Server

WiredRed recommends running e/pop as a service because it allows the server computer to the be
logged off while active. This is a common practice with most network administrators who manage
other server applications such as Microsoft Exchange and SQL.

You can control the e/pop server service by going to the Windows services menu.

The location for Windows services in Windows 2000, XP & Windows Server 2003 is located in

Start > Settings > Control Panel > Administrative Tools > Services

The location for Windows services in Windows NT4 can be found in
Start > Settings > Control Panel > Services

The e/pop server can also runs as a system tray application. Running e/pop server as a system tray
application is ideal for troubleshooting purposes.
Note: If you run e/pop as a system tray application, the computer cannot be logged off. If you want to
secure the server while running e/pop as tray app, you must lock the desktop using Ctrl+Alt+Del >
Lock computer feature.

Here are the steps to start the e/pop server tray application from Windows:

Start > Programs > EPop Server > ePop Server
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3.5 Step 2 - Configure the e/pop Server

3.5.1 Introduction to configuring e/pop Server

The e/pop server is preconfigured with default settings sufficient for most companies. If you need to
make changes to the e/pop server settings, you must use the e/pop Console program. The following
topics discusses the features offered in the e/pop console.

3.5.2 Overview - Server Console

The e/pop Console is used to administer the e/pop server. The following are two methods used to start
the e/pop Console.

Below are some of the options available in the Console. Please click on the link for more detailed
information.

· Pipes - Used for connecting e/pop servers together over a LAN, WAN or Internet

· Groups - Used for grouping e/pop users into logical groups that is maintain and managed on the
server

· Users - Used for managing e/pop accounts such as creating & deleting users

· Profiles - Profiles are used to filter the list of users visible in the Users directory. It works like a
buddy list that is managed on the server.

· Licenses - Displays the licenses on the e/pop server

· Chat rooms - Displays all active e/pop chat rooms and it's content.

· System Accounts - Used for creating special account with rights to use the Console or Pipe.

Note: Please click the Users link to understand how e/pop accounts are created in e/pop.

e/pop Server Console Application and the Server Settings menu
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3.5.3 Using the Server Console

The e/pop Server Console application is self contained application. It is available for use by the e/pop
administrator after installing the e/pop server. There are two methods to start the e/pop Server
Console.

· Double click the 'e/pop Console' icon on the desktop

· Click on Start > Programs > Epop Server > epop Console

Tip: The shortcut icon is a link to epopcon.exe and can be transferred between computers by simply
copying epopcon.exe to any computer on the network.  If you decide to transfer the e/pop console
application to another computer, it is recommended you create a shortcut icon on the new computer so
you can start the console without having to navigate to the actual folder where epopcon.exe resides.

Using the Console for the first time

When you run the console for the first time, you must add a new server to the server list. This is done
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from the file menu.

1. File > 'Add server'

2. When the 'Server' menu appears on the screen, enter a reference name and IP address for the
e/pop server.

Tip: You can enter a DNS or NetBios name for the IP address.

3. After creating an entry for the e/pop server, click OK and then click the Connect button.

4. After the console connects to the e/pop server, the toolbar will change and look like the image
below.
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3.5.4 Tips - General

Managing an e/pop server located in a computer room
If your e/pop server is located in a computer room or somewhere far from you, you should consider
transferring the e/pop Console to your local workstation. This allows you to perform routine
maintenance on the e/pop server without having to walk to the computer room. To transfer the e/pop
Console, simply run the essetup.exe program but do not install it as a service. Alternatively, you can
copy epopcon.exe from the e/pop server computer to your computer and create a shortcut on the
desktop for easy access. When you start the e/pop console you need to create an entry for the e/pop
server by clicking on the Connect button. After you click on the Connect button, you can create the
first e/pop server in the drop down menu.

Managing multiple e/pop servers
If you have multiple e/pop servers in your company, you can create multiple e/pop server entries in the
drop down menu. This allow you to manage multiple e/pop server from one physical location. You can
create multiple e/pop server entries by clicking on File > Add Server.

3.5.5 Configuring e/pop server via the Server Settings menu

3.5.5.1 Overview - Server Settings

The Console Server Settings menu is used for configuring specific settings related to e/pop. The
changes made to the Server Settings menu are stored in the TDSettings.* files and these files can
be copied to other e/pop servers if you want the servers to have identical settings.

Overview of the menu options in Server Settings
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Sever Settings menu Description
Server This tab control the global code and logging feature

Users The User tab controls options related to new user accounts

Security & Policy The server security policy tab defines the level of security
required by all e/pop clients and pipes

Chat The Chat tab controls the chat history

Message The Message tab determines the number of days messages
are retained on the server before being purged

SMTP The SMTP tab determines which SMTP server e/pop will
connect to when delivering e/pop message to an email
account

Ports The Ports tab determines the Ports used by the e/pop Server

Reporting Enables the Audit & Reporting feature

Reporting Details Controls the information the e/pop server audits

Reporting Advance Enables the Audit & Reporting queue on the e/pop Server

3.5.5.2 Server tab

The options in the Server tab control the server's ability to log e/pop activity to a text file and
assigning a 'Global Code' to the server.
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General

· Console log to disk
The e/pop server logs many e/pop activity like e/pop clients connecting to the server, status of pipes,
status of the e/pop Audit & Reporting server and any errors the server encounters. The activity is
displayed in the e/pop viewer and in a file called the epops.log which is located in the e/pop server
directory. The log file is a text file and helps WiredRed support engineers troubleshoot any errors you
may experience on the server.

· Global Code for e/pop Clients

The Global Code provides security and branding over your e/pop installation. The Global Code
specified in the e/pop server must match the embedded Global Code in the e/pop clients. If the codes
do not match, the incoming client connections will be rejected.

Tip: You can connect e/pop servers with different Global Codes and servers with no Global Code
together over Pipes. This technique is ideal if you want to offer a real-time communication channel to
users outside the company.

Location of Global Code in e/pop clients

3.5.5.3 Users tab

The Users tabs contain settings which control the default actions when new users are automatically
created on the server. By default new users are added to the Users group and visible to any user
running an unrestricted e/pop client.
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General

· Always assign the following profile to new users on this server
When enabled, the profile selected in the pull down menu will be the default profile for all new users
created on the server.

Note: This option only applies to newly created users on the local server and does not affect users who
already have an account.

What is a profile?

How to create a Profile?

· Send a message to the following user when a new user is created
When enabled, the user selected in the pull down menu will received an e/pop message indicating a
new user has been added in e/pop.

Tip: If e/pop servers are connected together via Pipes, you can select a remote users in the pull
down menu if the 'Remote Users' option in the Users section is selected.

User Settings Menu
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3.5.5.4 Security Policy tab

The options on this page controls the encryption e/pop uses when communicating.

Encrypt
Thre are currently 5 differnt types of encryption offered in e/pop. The options are

· RC4 encryption (default)
· RSA encryption with RC4
· RSA encryption with DES
· RSA encryption with Triple-DES
· RSA encryption with AES

Note: e/pop uses RSA 512 Bit

The selected security encryption defines the type of encryption e/pop will use when communicating
with other users on the same server and other e/pop servers connected via Pipes.

Note: If you decide to increase the ecryption from the default RC4, the e/pop clients will experience a
momentary delay when connecting to the e/pop server for the first time after the encryption option is
changed. The delay occurs because each e/pop client must create a unique Public certificate which is
stored in the TDCertificate files. Subsequent connections will be must faster.

General
The General section offers additional secuirty options which is explained below in more detail.
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· Always require accounts for users
When this option is enabled users must use a account and password to manually authenticate into
e/pop. This option is ideal if you want to offer a secure IM channel to business partners or other B2B
services.

· 0 Always require system accounts for pipes
This option is used to control or restrict incoming Pipes into the server. When enabled, incoming
Pipes must use a System Account that has been defined in the server accepting the Pipe connection.

·  Always require system accounts for console
When enabled the administrator must use a System Account to login and administer the e/pop
server. Please note you must create the System Account before you enable this option or you will
lock youself out of the server.

· Allow User Registration
When this option is enabled it allows users running the e/pop Java client to register a new account on
the e/pop server.
Note: This feature is not intended for the standard Windows client.

3.5.5.5 Chat tab

This option controls the number of lines sent to a user who joins a chat room that is already active. By
defualt the e/pop server will only send a maximum of 50 lines to a user who enters a chat room.
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3.5.5.6 Message tab

The options on this page controls the maximum attachment size in a popup message and the time to
purge pending messages.

Select one of the check boxes for the general preference of this server.

General

· Always limit the maximum message size

When enabled this option control the maximum attachment size allowed in a pop up message.
Please note the size is measured in bytes.

Purge

· Automatically purge message after XX Days, Hours & Minutes

When enabled this option automatically purges pending messages based on the specified time.
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3.5.5.7 SMTP tab

The SMTP feature allows users to forward pop up messages to any email address. When this option is
enabled and configure, the e/pop server will forward all messages address to an emailed address. The
e/pop message is then pickep up by any SMTP compatible device such as standard email accounts,
cell phones, PDAs etc.

· Enable SMTP

When enable this option turns on the SMTP feature on the e/pop server.

· TCP/IP

This option determines the SMTP server to receive e/pop messages.

Note: Some SMTP servers require authentication before it will forward SMTP messages. If the SMTP
server you intend to use requires authentication, you must specify the authorized account for mail relay
to work. Pleas contact your email administrator for this information.
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3.5.5.8 Ports tab

Use these settings to specify the TCP and UDP ports used for connections. Enter new values in
these fields if you want to change the TCP and UDP ports used by the server. The values must
match the port values specified in the e/pop client through the use of the e/pop control panel
application.

Enter the TCP ports to be used for client connections, console connections and real-time pipe
routing.

TCP

· Server (InP): Default 35000

· Console (InP): Default 35001

· Pipes In (InP/OutP): Default 35002

UDP

Enter the UDP ports to be used for communicating with the server viewer.

· Viewer (OutP): Default 35003
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3.5.5.9 Reporting tab

The e/pop server has the ability to forward all e/pop activity to an e/pop Audit & Reporting server (a.k.a.
e/pop A&R). The A&R server allows organization to view and print e/pop activity which include
messages, chat &, status.

Note: You must have an e/pop Audit & Reporting server in order for this feature to work.

Please click this link for more informaiton on the e/pop Audit & Reporting software.

General

· Enable Audit & Reporting
When selected the e/pop server will forward all e/pop activity to the e/pop A&R server.

Connection

· Name
Specify the descriptive name for the connection between the e/pop Server and A&R server

· TCP/IP
Enter the TCP/IP address of the Audit & Reporting server

http://www.wiredred.com/download_audit_reporting.html
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3.5.5.10 Reporting Details tab

The information on this page determines which e/pop activity will be logged.

General

· Location
Enter the location information you are tracking (i.e - Los Angeles or East Coast )

· Oranization
Enter the name of your organization in this field

Tracking

Select the features the e/pop Server will log.
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3.5.5.11 Reporting Advanced tab

In the event the connection between the e/pop server and e/pop Audit & Reporting is disconnected, the
e/pop server has the ability to queue all e/pop activity like status, messages, and chat in a local
databased called the TDAuditQue. The information is stored in the database until the Audit & Reporting
server becomes available or until the server reaches the purging time. By default the Audit Que queue
is disabled and when enabled, the information is queued for 7 days.

Advanced

Enable Audit and Reporting queue

When selected the audit queue is enabled.

The slider control the number of days information is retained in the audit queue database
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3.5.5.12 Tips - Server Settings

There are some tips you should consider when configuring the e/pop server.

· Secure your e/pop server for unauthorize access
Server tab
To secure your e/pop from unauthorize users, you should use the Global Code option. When this
option is set, any e/pop client connecting to the e/pop server must have the matching Global Code or
they will not be permitted to connect to the server.

· Alert the e/pop administrator when a new user is created
Users tab
The e/pop server can alert the e/pop administrator when a user is auto created on the server. When
this feature is enabled, you must select a designated e/pop administrator to receive the notification.
Note: If e/pop servers are Piped together, you must enable the 'Remote Users' option in the Users
menu if you want to notify an e/pop administrator on a remote server.

· Controlling the size of messages with attachments
Message tab
If you want to control the size of your users e/pop history database file (myhistory), you should reduce
the default message attachment size or disable the option completely. A value of ' 0 ' will force the
server to reject messages with attachments. Alternatively you can disable the attachment feature in the
e/pop client using the e/pop control panel.

Note: e/pop messages with large attachments will have a impact the overall performance of e/pop
server especially the message is addressed to a lot of e/pop users.
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· Forwarding e/pop messages to SMTP compatible devices
SMTP tab
Some companies require e/pop messages be directed to SMTP compatible devices like a PDA with
wireless access, Blackberry pager and some cell phones. If your organization requires this option, you
must enable the SMTP option and specify the name of an SMTP server.

· Managing TCP Ports
Ports tab
Avoid changing the Port value unless it is necessary. If you have to change the ports on the server,
make sure the e/pop client is configured to use the matching port or you will encounter connection
issues.

· Audit & Reporting options
Reporting tab
If you purchase the e/pop Audit & Reporting server, insure you give the connection a name that relates
to something in your company.

Reporting Details tab
For the Locations settings, you should enter the physical location of the e/pop server but keep the
organization consistant on all e/pop servers. Unless its is necessary, try to get all the e/pop servers to
forward their information to one e/pop Audit & Reporting server.
If you are using e/pop for alert notification purposes only, you should only enable Message option in the
tracking section.

3.5.6 Tips for securing the e/pop server

3.5.6.1 Ristrict client  connections to the e/pop server

The e/pop server will accept connections from any user running the e/pop client.If you want to control
access to authorize users only, you must use the Global code option.

3.5.6.2 Ristrict console access to the e/pop server

If you want to secure administrative access to the e/pop server, you must enable the 'Always require
system accounts for console' option which is located in the Security tab.
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3.6 Step 3 - Review your e/pop user requirements

3.6.1 Your end user requirements

Before you distribute e/pop to your end users, you must review their requirements and your company's
software policy. This is an important part of the deployment process because it will have an impact of
the overall administration of the e/pop clients after you distribute it to your end users. Below are some
tips to consider before you distribute e/pop.

· Do you have users who operate from different computers on your corporate network, i.e. Roaming
users?

· Do you have remote users, these are users who connection over a slow link like a 56k dial-up?
· Does your company have special restrictions they wish to enforce in the e/pop client?
· Did you review the differences between the available e/pop clients, e/pop Basic and Alert?
· Do you have a software distribution utility, like SMS, WinInstall, Tivoli to simplify the distribution

process?

There are other issues to consider but many are organization specific. If you have any question related
to the deployment proces, please contact WiredRed and we will be happy to assist you.
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3.7 Step 4 - Install the e/pop client

3.7.1 Overview

This topic discusses the process for installing the e/pop client, connecting to the e/pop server and the
various options available in the e/pop client.

3.7.2 Step 4a. Install the e/pop client

To install the e/pop client, you must first run the setup program. Below are the different setup programs
for e/pop.

· ebsetup.exe - e/pop Basic

· easetup.exe - e/pop Alert

Phase one
In the first phase of the installation process, the setup program will ask you a series of questions
related with decompressing the application files in the installation folder. For ease of use, we
recommend using the default option unless you need to change it.

Phase two
The second phase is the connection wizard. In this section, the wizard will ask you a series of
questions to help you connect to the e/pop server. Enter the IP address of the e/pop server and
continue with the installation until complete.
At the end of the installation the e/pop client will start and you will see the client interface.

3.7.3 Step 4b. Connecting to the e/pop server

When the client starts for the first time it will attempt to connect to the IP address of the e/pop server. If
the connection is successful, the client will display a green LED and the word 'Connected' at the botton
of the user interface.

During the initialization phase, the e/pop client creates a series of database files which are used to
store specific e/pop information. The database files are listed below.

· MyIdentity (.idx, .dat , .blb) - Used to store the Unique Identifier for the user using e/pop. These files
must be unique for any user using e/pop.

· MyHistory (.idx, .dat , .blb) - Used to store all e/pop messages.

· MyMacros (.idx, .dat , .blb) - Used to store message macros which are basically message templates.

· MyLocations (.idx, .dat) - Stores the location information which includes the IP address of the e/pop

· MyShortcuts (.idx, .dat) - Stores a list of users and personal groups which is displayed in the My
Shortcut view.

For more information on how e/pop accounts are created and managed on the e/pop server, please
refer to the 'Managing e/pop' section.

http://www.wiredred.com/downloads/ebsetup.exe
http://www.wiredred.com/downloads/easetup.exe
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3.7.4 Step 4c. Testing the features in e/pop

There are 4 different e/pop clients you can choose to install. These are

· e/pop Basic - ebsetup.exe

· e/pop Alert - easetup.exe

3.7.5 Step 4d. Customize the e/pop client

Once you have reviewed the features and you have an understanding of how they work, it is time to
customize it using the e/pop control panel.

http://www.wiredred.com/downloads/ebsetup.exe
http://www.wiredred.com/downloads/easetup.exe
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3.8 Step 5 - Configure the e/pop clients

3.8.1 Customizing the e/pop Client

Customizing the e/pop client is done through the e/pop Control Panel Program. The e/pop Control
Panel is a generic application that's available with all clients. The Control Panel is a unique
application because it allows the administrator to set specific options in e/pop and to store the
settings in the e/pop execatable file by recompiling it. Also, before you save the configurations, you
can secure the setting using a password which protects the settings.

Below are the basic steps for using the e/pop Control Panel

Step 1. Start the e/pop Control Panel

Step 2. Click the Open button located at the bottom of the control panel

Step 3. Navigate to the location of the e/pop executable file (path where e/pop was installed)

Step 4. Double click the main e/pop executable file

Step 5. Make the appropriate changes in the Control Panel

Step 6. Click the Save to save the settings

Note: The e/pop application cannot be running if you want to save the changes in the e/pop Control
Panel

3.8.2 Starting the control panel

You can access the e/pop Control Panel from either the Help menu of e/pop or the application group
for e/pop in the Start menu.
Note: The e/pop control panel can also be launched by double clicking epopcp.exe located in the
e/pop installation directory.

Select one of the following options to start the e/pop control panel program

1. From the Help Menu in the e/pop client

2. Start > Programs > ePop > ePop Control Panel

3. Double click epopcp.exe in the e/pop installation folder

3.8.3 Opening the e/pop Application File

To customize the e/pop client, you must first open the e/pop executable file in the e/pop control panel
program. This is accomplish by selecting one of the following steps below.

1. Click the Open button at the bottom of the control panel window and nevigate until you find the
e/pop executable file (i.e. epop.exe)
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2. From the file menu select 'Open e/pop application' and select your e/pop executable file.

Note: After opening the EPop.exe file the Save button in the Control Panel becomes active and the
full path of the e/pop executable will be displayed in the title bar.

Tip: The name of the e/pop client program itself (EPop.exe) can be modified to meet your
requirements. The Control Panel embeds the changes directly into the EPop.exe file, so making copies
of the EPop.exe file with various names prior to customizing it in the control panel and applying
different settings can provide your users with different access levels.

3.8.4 Hiding Access to the Control Panel

If you do not want the Control Panel menu item to display on the e/pop Help menu, you can hide it
from being displayed. By removing the EPopCp.exe file from the installation directory, the e/pop
Control Panel users cannot view or access the e/pop Control Panel. Additionally, e/pop includes
extensive security features to prevent people from making changes to an e/pop application by using
the Global Code feature.

e/pop with the epopcp.exe in the install folder.
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e/pop without the epopcp.exe in the install folder.

3.8.5 Feature Controls

The Control Panel contain many options found in the e/pop client under the Options menu. With the
control panel you can control the default behavior of e/pop by forcing the options to be enabled or
disable when e/pop starts. Also, this is a good method of making the users environment consistant.
Although it is a good idea to have a consistant setting, it can increase the administrative overhead
because your users may demand access to options to help them be more productive. We highly
recommend reviewing the benefits when using some of the features in the e/pop Control Panel.

As you review the e/pop Control Panel, you will notice a set of options on the left and right. Each
option on the left correspond with an option on the right. The image below illustrates this. Most of the
options in the control panel are self explanatory so please review them in detail. If you need more
information on any specific option, you can review the Control Panel section.



Deployment

e/pop Admin Guide

47Step 5 - Configure the e/pop clients

This topic describes using the e/pop Control Panel to pre-configure the e/pop client with restricted
features and the default configuration. The Control Panel lists the features options and their setting.
Refer to the Quick Reference for brief descriptions of the general settings included such as:

· Enforce or restrict features

· Storage location for personal files

· Directory and network access

· Security options.

3.8.6 A Quick Guide to Control Panel Settings

The following table provides a brief description of the settings available in the e/pop Control Panel.
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e/pop Control Panel
options

Description

General Display the splash screen and the tray icon.

Exit Display and control the ability to exit.

Restrictions Disable ability to access e/pop, dialogs, menus and functions

 Options Disable access to option controls as well as specific option pages

Workgroups Specify general preferences for workgroups and settings for default
workgroups

My Files  Specify location and paths for user personal files (history, message,
macros and shortcuts)

My Files (continued) Specify location of the mylocaitons files and user specific features to
enable

Status Specify default personal status message(s) and status related options

Features - Send Controls a users ability to send selected features

Features - Receive Controls a users ability to receive selected features

Confirmation Send Specify whether confirmations are required when sending to multiple
recipients as features

Confirmation Receive Specify whether receive confirmations are optional, required or
removed as features

Sounds Specify sounds for new messages and chat sessions

 Message Specify message preferences and default archive location for
messages

Message (continued) Specify message preferences

Chat Specify preferences for chat

Networks Disable specific directory objects from communications

Domain Preferences for NT Domain integration

Domain (continued) Perference for NT Domain objects in the directory

ADSI Perferences for ADSI integration

NDS Perferences for Novell NDS integration

GroupWise Perferences for Novell GroupWise integration

Identity Controls the visual identity of users in the e/pop directory

Directory Perferences for the e/pop directory/User list

Protocol Perferences for using specific protocols and TCP ports

Advanced Protocol Specific preferences for support protocols

Security Secures the e/pop executable and advanced messaging options

3.8.7 Control Panel Options

3.8.7.1 General Options

Use the General settings to specify if the splash screen and the tray icon displays when you start
e/pop.
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Splash
This section controls the behaviour of the splash screen when e/pop starts.

· Default - Set to user's preference

· Never show splash screen

· Always show splash screen

Tray
The option in this section controls the behaviour of e/pop after it starts.

· Default - Set to user's preference

· Always minimized in the system tray

· Always minimized in the task bar
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3.8.7.2 Exit Options

Use the Exit settings to prevent users from exiting e/pop and how e/pop responds when a user
attempts to exit using the close button X.

General

· Completely disable the ability to exit -  If enabled, users cannot exit e/pop using any of the available
options in e/pop.

Confirm

Select one of the following to specify whether or not a confirmation message is displayed when a user
attempts to exit e/pop using the close button.

· Default - Set to users preference

· Always ask - When attempting to exit from the close button, e/pop displays a confirmation
message.

· Always exit - When attempting to exit from the close button, e/pop exits.

· Always minimize - When attempting to exit from the close button, e/pop minimizes instead.
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3.8.7.3 Restrictions Options

The option on this page control the behaviour of the e/pop client when it is active. When will be
enforced when enabled.

Activate

Completely disable the ability to activate e/pop

When enabled, the user will not be able to activate the e/pop user interface after e/pop starts. This
options is ideal when the administrator want to prevent users from interacting with the e/pop client or
prevent users from changing the enforced settings.

Note: When this option is enabled, it superseeds all the options in the section below. Since there is no
user interface, there is no way for users to changed any of the e/pop settings.

Specify
The list of options in this section disables specific features in the e/pop client.

Note: If the above option is enabled, enabling any of these options will be redundant.
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· Disable Tray Icon - This option prevents the e/pop tray icon from being visible (Note: This option
superseeds all the options below)

· Disable access to the tray menu - This option prevents the tray menu to appear when a user right
clicks on the tray icon. This means users will be aware that e/pop is active but they cannot interact
with the tray menu (Note: This option superseeds all the option below).

· Disable access to the Do Not Disturb - Removes the Do Not Disturb option

· Disable access to edit status messages - Removes the ability to edit status messages

· Disable access to change your status - Removes the ability change status

· Disable access to edit auto reply messages - Removes the ability to edit the auto reply messages

· Disable access to change your auto reply - Removes the ability change the auto reply feature

· Disable access to modify locations - Removes the ability to change any entry in the locations menu

· Disable automatic away status - Prevents e/pop from automatically changing a users status to away

· Disable server disconnected balloon - Prevents the server disconnect balloon from appearing

3.8.7.4 Options (Feature Access)

General

Use these settings to disable access to specific pages and features within e/pop Client Options
menu. Select one of the following preferences for controlling e/pop Options:

· Completely disable access to Options - When enabled, the Options button is removed from the
toolbar and in the tray menu.

Note: This option superseeds all other options on this page

· Disable access to `run when Windows starts'
When this option is enabled, it removes the 'Run when Windows start' opion from the Options menu.
Note: The run when Windows starts option places a shortcut in Windows Start up menu.

Disable

You can disable specific pages in the Option menu by selecting approriate page.
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3.8.7.5 Workgroups Options

The workgroup feature is similar to Windows workgroup that is displayed in Network Neighborhood
where it can only be managed from each workstation. The big difference between the two workgroup
feature is a user in e/pop can be a member of multiple workgroups whereas a user in Windows
workgroup can only be a part of one workgroup at any given time.
e/pop workgroups are managed on the client side and there is no central management for it. To
prevent users from adding themselves into unnecessary or unwanted workgroups, it may be a good
idea to disable this option completely by selecting the first and second options under the General
section. By enabling these 2 options, users will not be able to create unwanted workgroups in the
e/pop user list.

General

Select one of the following to set general preferences for workgroups:

Disable the ability to modify workgroups - When enabled, the user is prevented from adding,
removing or changing the workgroup

Use only the workgroups specified - When enabled, access is limited to the workgroup or
workgroups the user is assigned
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Always include the default network workgroup -  When enabled, this option will display the
workgroups displayed in the Network Neighborhood

Always exclude the default `User's' - When enable, the defualt 'Users' workgroup will not be visible
in the e/pop user list

Workgroups

Add, delete or edit a specified workgroup or workgroups to be included by default. These workgroups
will appear for each user running the e/pop application, in addition to any workgroups they have
already specified. To restrict the workgroup(s) to only those indicated in the e/pop control panel,
select the option 'Use only the workgroups specified' in the Genereal section.

Note:  If you add or edit workgroups, it will create entries in the local workstations registry. Deleting,
however, will NOT remove it from the local workstation registry. Enabling the option 'Use only the
workgroups specified' will remove any workgroups from the local workstation registry.

3.8.7.6 My Files Options

The settings on this page indicate where e/pop will store and search for the users personal files. The
personal files are all the files that begin with 'my'. These files are

MyHistory - Stores all the pop message files

MyIdentity - Store the identity information which is unique to the user running e/pop

MyLocations - Store the name and IP address of the e/pop server

MyMacros - Stores all the message macros

MyShortcuts - Stores all the information in the MyShortcut section

General

Select the preferred location for storing the 'My' files. Please note the specified location is specific to
certain operating systems.

Default - This is the same location as the e/pop executable file or the location specified by the user in
the 'Options' menu.

Profiles Files - This is the default installation directory

Documents and Settings - This is the user's profile folder located in the Document and Settings
folder for Windows 2000 / XP and above. This settings apply to Windows local profiles.

Windows Profile - This option is used in conjunction with Windows roaming profiles. Do not select
this option if you are not using Windows roaming profiles.

NetWare NDS Home Directory - This option stores the e/pop personal files in the location entered in
the Home field in the Netware administration utility. Note: Users must also use the Novell Client 32
software to logon to the Netware server for this option function correctly.

Specify the location for user personal files - This option is used to store the MyFiles in any
location like a drive letter that is mapped to a specific folder on a file server (Home directory). You
can specify the full path for the MyFiles, example: ' h:\epop ' and e/pop will create the folder if it
does not exist.
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3.8.7.7 My Files (Continued) Options

This page is a continuation for the My Files preferences.

General

Always use a shared MyLocations file that is maintained with the shared client application -
When enabled, the e/pop client will search for the location information (e/pop server's IP address) in
the same folder where e/pop started. This option is ideal for users running e/pop as a shared
application or for users who share computers and the e/pop program is located on the local computers.

Always create a shortcut icon in the startup folder and on the desktop of Windows - When
enabled, this options creates an e/pop shortcut on the desktop.

Features

Select whether user specific personal files for message history, macros and shortcuts are always
enabled, disabled or selected by the user.
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· History
· Macros
· Shortcuts

3.8.7.8 Status Options

You can include standard status messages within an e/pop application by creating them within the
e/pop Control Panel.  Status messages created in the e/pop Control Panel are added in addition to
any status messages created by the user within the program.

Status Message

Adding and editing will create entries in the local workstations registry. Note: Deleting entries from the
control panel will NOT remove the entry from the local workstation registry. To remove a status
message from the local workstation, you much visit each PC and remove the status message in
question.

Options
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Specify the details for status messages to appear in the e/pop directory.

 

· User details

· Contact info

· Time stamp

· Date stamp
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3.8.7.9 Features - Send Options

The Features - Send option allows you to control a users ability to initiate the features in e/pop. By
default a user will have ability to initiate all the features in the e/pop client. If you decide to remove a
users access to use (initiate) a feature, you can disable the feature on this page. The options are
typically used by administrators who want to restrict users access to specific features.

Send

Select users access preference to features in e/pop. Any option you disable, the corresponding
feature will be competely remove from the e/pop client.

The available options are

· Enable - If selected, the feature will be enabled and accessible by the user.

· Disable  - If selected, the feature will be disable and option to initiate the feature will be completely
removed from e/pop.
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3.8.7.10 Features - Receive Options

The Features - Receive option of the Control Panel allows you to control which user has the ability to
receive an e/pop feature after it is initiated by another e/pop user. The options on this page is typically
left to the default settings because most organization require users to receive a feature after it is sent.

Receive Features Options

Your option for controlling a users ability to receive a feature within e/pop are

· Default - Set to the users preference

· Enabled - Enables a users ability to receive this feature

· Disabled - Disables a users ability to receive this feature
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3.8.7.11 Confirmation Send Options

Confirmation Send Options

The Confirmation Send option determines whether a confirmation is required before a feature can be
performed against a group of users. By default, the individual e/pop user decides the confirmation
and sets the option in their e/pop options.  You can make confirmations mandatory by enabling the
confirmation or always prevent a confirmation by disabling the feature.

3.8.7.12 Confirmation Receive Options

The Confirmation Receive option determines whether you require a confirmation before an e/pop
feature can happen on a user's workstation.  By default, the individual e/pop user decides the
confirmation and sets the option in their e/pop options.  You can make confirmations mandatory by
enabling the confirmation or always prevent a confirmation by disabling the feature.

Select option for each feature.

· Default - User decides in their own e/pop options whether specific features require a confirmation.
· Enabled - Confirmation messages are always required and displayed.
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· Disabled - Confirmation messages are not displayed.

Note: To always require a user to confirm a remote control session request, enable the confirmation
for remote control.  By setting a confirmation to enabled or disabled in the e/pop Control Panel, you
are circumventing any preference the user has selected in e/pop options.

3.8.7.13 Sounds Options

Use the Sounds Option settings to specify sounds for new messages and chat session invitations.

Message

· Play the following sound when a new message arrives.

Click Browse to open a sound file, such as Pop.wav.

Chat

· Play the following sound when a chat session invitation arrives.

Click Browse to open a sound file, such as Pop.wav.
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3.8.7.14 Message Options

Use the Message Option settings to specify preferences for receiving, sending, composing and
saving messages.

Message

Select one of the following general preferences for messages:

· Disable the ability to send file attachments - The default file attachment size is 5 MB.  If you
enable this option, users will not be able to send IM messages with attachments.

· Disable the ability to reply or forward - This feature disables the forward message feature.
· Disable the ability to modify the recipients - This feature disables the forward message feature.
· Disable the ability to export messages - This feature disables the export feature in a message.
· Disable the subject - This feature disables the subject line in a message.
· Suspend the screensaver to display messages - This feature suspends the screen saver when

a message arrives.
· Always use sender's name as message caption - This option displays the sender name in the

message title bar.
· Always show message header details when replying - This option displays the message header

in the message titile bar.

 Save To

Specify the location to save (exporting) messages.

· Click Browse to select a directory location.

3.8.7.15 Message - (continued) Options

The options on this page are additional properties for messages

General
Display new message using the following preferences.

· Default - Allows the user to decide in the Options menu.

· Always show - Force new message to display on the screen

· Always show inactive - Force a message to be visible as a flashing icon in the system tray and
when the user double click on the icon, the message appears on the task bar.

· Always prompt before showing - e/pop request confirmation from the user before displaying the
message.

· Always hide - e/pop flashes an icon in the system tray for new messages

Windowed
Select the preference for how messages are displayed on the screen.

· Default

· Single Window

· Cascade Windows

3.8.7.16 Chat Options

Use the Chat Option settings to specify preferences for composing, exporting, printing and copying
within a chat session.

Chat General Preferences
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Select one of the following general preferences for chat:

· Disable type-ahead feature for chat messages - Disables the ability to see individual characters
of a user's response before they send the chat message.

· Disable the ability to export chat - Prevents users from saving (exporting) chat session.

· Disable the ability to print chat - Prevents users from printing chat session.

· Disable the ability to copy within chat - Prevents users from copying within a chat session.

3.8.7.17 Networks Options

The Objects option prevents select objects from being visible in the e/pop directory. You can refer to it
as a built in filter. To use it simply specify the object name by the syntax used in e/pop.

Example
To disable the NT Domain group 'Administrators', you must enter D=Administrators.

Below are all group references in e/pop

W=e/pop workgroup
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G=e/pop server group
D=NT Domain group
N=NDS group
GW=GroupWise distribution list

Tip: Many organization typically use this option to remove the default Users workgroup.

3.8.7.18 Domain Options

Use the Domain Options settings to specify preferences for NT Domain integration with e/pop.

Note: Domain objects can only be manage via the management utility in Windows.

General

If you want to integrate your Windows NT4 Domain in e/pop, you must enable the option before the
e/pop client will extracts the appropriate information from the nearest NT4 Domain controller.

· Enable support for NT/2000 Domains (Note: This option is only for NT4 Domain integration)

· Always include the domain name in the directory - This options will become active after you
enable the NT4 Domain integration (above). This option instructs e/pop to display the Domain
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name as a top level object in the Directory.

Domain
The first option is designed for offices with multiple NT Domains. Depending on the type of NT
Domain model you have, you might consider entering the names of the trusted Domain in the edit
box.
Note: Many organizations follow the Master/Resource domain model where users authenticate into
the network through a Master Domain. The Master Domain is then trusted to the resource Domain for
access to resources. In the Master Domain model, it is not necessary to enter the Domain name of
any of the resource Domain.

The second option forces e/pop to query a specific Domain controller. In this section you must enter
the Domain controller that is closest to the user. Note: Do not enter the name of a Domain control
that across a wide area network because the response will be slow.

3.8.7.19 Domain (continued)

When you integrate the NT4 Domain in e/pop, the directory may become cluttered and sometimes
confusing to a user. If this is the case in your environment, you should consider removing the top level
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object so user do not have to drill down the Directory to locate a user. Simply enter the object by its
visual name to remove from the e/pop directory.

Tip: This option is ideal if you only want to remove the top level object, not specific groups within the
Domain.

3.8.7.20 ADSI Options

By enabling this option, the ADSI directory will integrate into the e/pop directory.
The requirements for ADS integration are,
1. Verify the workstation can ping the ADS domain by name.

2. Insure the workstations are authenticating to ADSI as a native ADS client.

Once you meet the above requirements, you can integrate ADS into the e/pop Directory.
Note: ADS objects can only be manage via the management utility in Windows.

General
Specify the general perferences for the ADSI network.

· Enable support for ADSI - This option activates the ADSI integration in e/pop
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· Always use a flat ADSI directory structure - ADSI is a hieratical type directory structure which
means containers can have multi levels. This option prevents the different levels in the ADS and
restructures the directory to flat legacy Domain.

ADSI
This option instructs e/pop to query a specific Domain controller (DC). In most cases this option is not
necessary because the request is automatically dispatched to the closed DC. This option is ideal if your
ADSI Domain spans a WAN and you want the query to the processed by a DC closest to the user.

Directory
This option displays an optional top level group in the ADS structure if requred.

3.8.7.21 Netware NDS

This option integrates NDS into the e/pop directory. When enabled, the e/pop clients makes request to
the NDS server for the user information and populates the e/pop directory with the appropriate
information. This feature requires each client to have the Novell Client 32 installed.

Note: When the NDS tree is integrated with the e/pop directory, it will appear as a hierarchical
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structure. The NDS object can only managed via Console One or Nwadmin utility. Note: Changes done
to any NDS object is dynamic if when will only take effect when users restart e/pop.

General

· Enable support for NDS - This option enable the NDS in e/pop

· Exclude group memberships - When enabled, it excludes all groups a users belongs to.

· Exclude user contexts - When enabled, it excludes the NDS context

3.8.7.22 Groupwise

Similar to NDS, the you can integrate the Groupwise global address list into the e/pop directory. By
enabling this option, e/pop will query the NDS server for the appropriate Groupwise information and
populate the e/pop Directory.

Note: When the Groupwise object is integrated with e/pop, it will appear as a flat structure and it can
only be managed using the utilities provided by Novell.

General
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· Enable support for GroupWise - This option enables integrates the GroupWise Global Address
List in e/pop.

Group

This option allows the administrators to control the top level GroupWise group in e/pop.

3.8.7.23 Identity Options

Use the Identity Option settings to specify a user's visual identity in the e/pop Directory.

Identity
Select one of the following to specify how users control their identity.

· Default - The identity is based upon the users network login or computer name. Users can
change their identity at any time by using Options.

· On the first run, set the user's initial identity - The identity is initialized to the network
preference (as indicated in Advanced Protocol illustration) the first time that e/pop is executed.
The users can change their identity at any time, using Options.
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· On each run, set the user's identity - The identity is initialized to the network preference (as
indicated in Advanced Protocol illustration) each time that e/pop is executed.

Network
Select one of the following as the source of the user's identity:

Machine name - The identity is based upon the computer name specified in Window's Network
Identification settings.

Login name - The identity is based upon the login name.

Account name - The identity is based the account name that was manually created on the server
NDS full name - The identity is based upon the full name field of the NetWare NDS.

Domain full name - The identity is based upon the full name field of the NT User Manager for the
default domain.
ADSI full name - The identity is based upon the full name field of the ADS manage for the default
domain.
GroupWise display name - The identity is based on the display name in the global address book

3.8.7.24 Directory Options

Specify preferences for the Directory options and remove access to specific network directories.

General

Select one of the following general preferences for controlling the Directory:

· Completely disable access to the directory - Disables the ability to access objects in the
directory, essentially removing a user's ability to send any e/pop features.

· Completely remove offline users from the directory - Removes users within the User's
network as they go offline.

· Completely disable the ability to receive user status - Prevents the e/pop user from receiving
any user status from other e/pop users

· Show My Shortcuts on startup - Displays the users in MyShortcut as the default directory view

Specific

You can remove any particular network directory from the e/pop directory view by selecting one of the
following.
Note: Only the enabled directories will be available for selection.

· NetWare NDS

· Windows NT/2000 Domain

· ADSI (Active Directory Services Interface)

· GroupWise
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3.8.7.25 Protocol Options

Protocol
Use the Protocol options settings to specify any protocol adjustments to be included in an e/pop
application for network communication. Select one of the following as the default protocol:

Default - The protocol is based upon the user-selected option.

IPX/SPX - The protocol is enforced and is always IPX/SPX.

IP - The protocol is enforced and is always IP.

UDP Ports

Specify the base ports for peer UDP communication:

IPX (InP/OutP): (Default=25004)
IP (InP/OutP): (Default=35004-35006))

TCP Ports
Specific base ports for server TCP communications
Server (OutP): (Default=35000)
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3.8.7.26 Advanced Protocol Options

Protocol

e/pop only uses TCP/IP when communicating with the e/pop Server. All option options are obsolete.

TCP Ports

e/pop communicates with the e/pop Server on TCP port 35000 by default. You can change the port in
the client but you must ensure it matches the values indicated in the server console.

3.8.7.27 Security Options

The Security Options settings is used to secure the e/pop executable that is modified by the e/pop
control panel. The global code is also used to control communications within an organization to only
authorize e/pop clients with matching global code. When the global code is specified in the server,
the server will only accept connection from e/pop client with the matching code.

Global

· Code: Enter any alphanumeric value for your global code

· Always require matching global code: You can enter the same global code on the e/pop server
so only e/pop client with the matching code can communicate with each other.

Message

· Code: Restrict sending commands from an e/pop message
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3.9 Step 6 - Distribute the e/pop clients

3.9.1 Overview - Distribute the e/pop client

After the e/pop client is custom configured, it is time to select a distribution method. Here are the
options you can use to distribute e/pop.

· Use a software distribution utility (Recommended option)

· Using a login script to push the e/pop clients to each computer

· Distribute e/pop using a batch file

· Run e/pop as a shared application

Each distribution option have advantages and disadvantages specific to a organization. You should
review each distribution method in detail before making your decision.

3.9.2 Using a software distribution tool

Deploying e/pop via a software deployment utility is the recommended method for large deployments.
Using this method, a custom configured e/pop client can be created, and deployed to every user on the
network with little effort. Besides deploying e/pop, the software deployment utility can be used to
update e/pop if needed.

Details

Step 1. The first step in the deployment process is to install the e/pop server on a Windows server PC
(NT4, 2000 or Win2K3). Select all the default options during the install and set e/pop server to run as a
service (recommended option). Document the IP address the wizard returns because it will be used in
the next step.

Step 2. Using a software deployment utility take a 'before snapshot' of the PC that you intend to install
e/pop.

Step 3. Install the e/pop client and configure it to connect to the e/pop server. Run the client setup
program and walk through the connection wizard. Enter the IP address you documented in Step 1 and
test the connection. If the test is successful, e/pop will create a set of mylocation.dat and
mylocation.idx files with the correct IP address and store them in users personal directory. If the test
fails, insure you entered the correct server IP address or PING the server to insure the server is
reachable.

Step 4. Create a custom e/pop executable file using the e/pop control panel program.

Step 5. In step 4, you must delete the myidentity files if they are present in the e/pop directory. This is
an important step because failure to do so will result in users running e/pop that reference the same
user object in the 'Users' directory. Example: Let say user 'John Doe' and 'Jane Smith' run e/pop with
the same myidentity files. When John Doe runs e/pop first thing in the morning, he appears in the
directory as a user object labeled John Doe. Later that morning, Jane Smith runs e/pop, connects to
the server and she expect to see John in the directory. Since Jane is using the exact same identity files
as John, she replaces John's user object with her own.
Again, to prevent this error, you must delete the identity files in the e/pop directory prior to deploying
e/pop.

Step 6. Using your software deployment utility take an 'after snapshot' of the PC with e/pop.

Step 7. Deploy the software package to each PC.

3.9.3 Using a batch file

Although the preferred method for distributing e/pop is to use a software distribution utility, batch files
can also be used to distribute e/pop. For a sample copy of the batch file please click the link below to
download it from WiredRed's website.
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Batch file to deploy e/pop Alert

Batch file to deploy e/pop Basic

3.9.4 Run e/pop locally

3.9.4.1 Files needed to run e/pop Basic locally

After installing and configuring e/pop Basic on a PC, you can create a custom software distribution
package that contains the following files. If you installed the e/pop Basic client using the ebsetup.exe
file, the application files will be located in c:\program files\wiredred\epop.

EPop.exe
MyLocations.dat
MyLocations.idx
Alert1.wav
Alert2.wav
American.adm
EPop.cnt
EPop.hlp
EPopCP.exe
EPopI.dll
EPopWiz.exe
ipworks6.dll
Offline.wav
Online.wav
Pop.wav
Radmin32.dll
Rlocal32.dll
Roget.adt
LogonSvc.exe
unins000.dat
unins000.exe
Welcome.rtf
XSvc.exe

It is not necessary to include any of the other my*.* files in the package.

IMPORTANT: You must exclude the myidentify.idx and myidentify.dat files from the distribution
package because these files are unique to each user.

3.9.5 Run e/pop as a shared application

3.9.5.1 e/pop for users using Metaframe or Terminal Services

Users who use Metaframe (MF) or Terminal Services (TS) as their primary network environment must
run e/pop as a shared application. In this method e/pop is installed on a network shared and all MF/TS
users run a single copy of e/pop from the share. Before you run e/pop as a shared application, you
must ensure the user's environment is set where each user has a drive letter mapped to a their home
directory. Typically administrators will use a user's home directory to emulated the C drive and map
another drive letter to a shared space on the MF/TS server. When the environment is set, it should
look something like this.

C:\ >  - This is the users home directory which is unique and private to the user in question.
M:\ >  - This drive is the shared space on the MF/TS server. This is also the location where shared
application are installed.

This type of configuration is design so users feel like they're actually sitting at a computer instead of
being in a MF/TS session.

http://www.wiredred.com/downloads/deployepop.zip
http://www.wiredred.com/downloads/deployepopbasic.zip
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Note: Please refer to your MF/TS guide for details for setting the user's environment.

TIP: There are variations to the example decribed above. As long as each user has a drive that is
mapped to their home directory and shared location to host e/pop, running e/pop as shared application
will work without any issues.

3.9.5.2 e/pop for standard network users

An alternative to installing e/pop locally on each workstation is to install e/pop as a shared application.
This installation method requires all users to run e/pop from a shared folder. The advantage of running
e/pop as a shared application is it eliminates the need to push e/pop Basic client to each desktop.

IMPORTANT: This method is limited to no more than 50 users.

The requirements for running e/pop from a shared folder are

1. The CPU on the file server must have sufficient processing power. This is an important criteria since
the file server may already be servicing other applications.
2. Sufficient RAM for e/pop.
3. Each user must have a unique location to store their personal e/pop files - i.e. a drive letter mapped
to the user's home directory.
4. Sufficient right to read from the shared e/pop folder.

The configuration below describes the proceedure for configuring e/pop to run as a shared application.

Steps to setup e/pop as a shared application
1. Install e/pop on any workstation

2. Configure e/pop using the e/pop control panel.

3. In the e/pop control panel, the following options must be set
a. Specify a location for the 'My Files' - See 'My Files' seciton
b. Instruct e/pop to use a shared MyLocation file. See 'My Files (continued)' section

4. Configure other settings it needed (click here for more information).

5. Copy the entire e/pop folder to a shared location on the file server.

6. Go into the shared e/pop folder and delete the following files (important).
- myidentity.idx
- myidentity.dat

7. Configure the workstations to start e/pop from the shared location using any one of the following
methods.

a. Place a shortcut in the 'All User' Startup folder or the Startup folder under each users folder
in the Document and Settings folder.

b. Configure the login script to start e/pop
Example of a Windows login script:

----------- Start of login script -----------

     Start c:\"program files"\wiredred\epop\epop.exe

----------- End of login script  -----------

Note: The 'START' command is an internal/reserved command to Windows which was designed to
start an application for the login script without affecting the login script in anyway.

Disclaimer
Due to technical limitation of login scripts, WiredRed does not provide technical support to customers
who choose to start e/pop from a login script.
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3.9.6 How to update e/pop

3.9.6.1 Local install

The procedure for updating e/pop is to simply replace all the e/pop application files with the updated
version. Use one of the methods described below to update e/pop.

First method
Run the setup program and installing e/pop over the existing version. This methods is relatively simple
can be done by the e/pop administrator or by the end user. If you want the end user to update e/pop,
simply give the user access to the e/pop setup program and instruct the user to install e/pop over the
existing version.
Note: The setup program will retain all the user selected settings but will loose any settings that were
set via the e/pop control panel.

Second method
The second method for updating e/pop is to use a software distribution utility. This method is ideal for
environments where e/pop was customized using the e/pop control panel. The information below
describes the steps you must follow if you choose to use this method.

1. Install e/pop on a spare workstation

2. Open the previous version of the e/pop executable file in the e/pop control panel

3. Export the settings from the File menu to a file. The exported file will have an extension
'.ecp'

4. Open the new e/pop executable file in the control panel

5. Import the settings '.ecp' file from the File menu

6. Enter the Gobal Password and save the settings

7. Create a distribution package contain all the new e/pop application files

8. Push the package to users who have e/pop

Third method
The last method for updating e/pop is to use a batch file. The procedure for updating e/pop with a
batch file in similar to the second method except you have to run the batch file manually, through a
login script or to use the Remote Admin>Run feature in the e/pop client. The information below
describes the steps you must follow if you choose to use this method.

1. Install e/pop on a spare workstation

2. Open the previous version of the e/pop executable file in the e/pop control panel

3. Export the settings from the File menu to a file. The exported file will have an extension
'.ecp'

4. Open the new e/pop executable file in the control panel

5. Import the settings '.ecp' file from the File menu

6. Enter the Gobal Password and save the settings

7. Copy the entire e/pop folder to a shared folder on a file server.

8. Go to the shared folder and delete any file that beign with My*.*

9. Create a batch file to copy the content of the shared e/pop folder to each workstation.

Click here to see a sample batch file to update e/pop Alert

Click here to see a sample batch file to update e/pop Basic

Note: You may experience an issue in Windows where the DOS window remains open after the batch

http://www.wiredred.com/downloads/deployepop.zip
http://www.wiredred.com/downloads/deployepopbasic.zip
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file completes. This issues occurs because Windows pauses the DOS window indefiniately when you
start a application from a batch file.

3.9.6.2 Shared install

In order to update a shared version of e/pop, you must ensure the e/pop program is not active on any
computer. When all users have exited e/pop, you can proceed with the update process. Again the
update process is to replace all the e/pop application files with the updated version.
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4 Managing e/pop

4.1 Controlling a user's identity in the Directory

4.1.1 Overview

A user's visual identity in e/pop is important especially if users plan to direct messages to other users
within the e/pop system. You can compare the e/pop Directory to a global address list in an email
system. For this reason you must decide how you want the e/pop Directory to be presented to e/pop
users. e/pop offers a variety of identity options which allows companies to force e/pop to use the same
visual identity each time it starts. Organizations who do not want to implement this strict identity policies
can allow users to specify their own identity using the Options>Identity option in the e/pop client.

A user's identity in e/pop can be set to following

1. Machine name (default)

2. Login name

3. Full name extracted from ADS, NT4, NDS or Groupwise

4. The account name specified in the e/pop Console.

Note: The options to control a user's display name is done in the e/pop Control Panel. If you decide to
use the account name as the visual identity, you must manually set the account name in the Console
and then force the client to use the account using the Control Panel.

4.1.2 Set the identity to Machine name

You can set the user's visual identity to computer's machine name. Note: Machine name is the default
identity in e/pop.
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4.1.3 Set the identity to Login Name

You can set a user's visual identity in e/pop to the user's login name by enabling the option below.
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4.1.4 Set the identity to ADS display name

You can set a user's visual identity in e/pop to the user's ADS display name providing the information is
completed in ADS. Note: This is a two setup process.

Step 1. Enable the ADS integration and specify the ADS domain name. Note: The ADS name must be
a reslovable name. Example: You can ping the ADS Domain name from DOS.
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Step 2. Set e/pop to use the ADS display name in e/pop.
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4.1.5 Set the identity to NT Domain full name

You can set a user's visual identity in e/pop to the user's NT full name providing the information is
completed in the NT Domain. Note: This is a two setup process.

Step 1. Enable NT Domain integration and specify the user's logon Domain name.
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Step 2. Set e/pop to use the user's NT Domain full name in e/pop
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4.1.6 Set the identity to NDS full name

You can set a user's visual identity in e/pop to the user's NDS full name providing the information is
completed in NDS. Note: This is a two setup process.

Step 1. Enable NDS integration
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Step 2. Set e/pop to use the user's NDS full name in e/pop
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4.1.7 Set the identity to Account name

You can set a user's visual identity in e/pop to the user's Account name. In order for this feature to
work, the user must have a manually created account on the e/pop server. Note: This is a two setup
process.

Step 1. Create an account in e/pop
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Step 2. Set the identity information in e/pop to use the account name.
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4.2 Managing your e/pop users

4.2.1 Working with e/pop accounts

4.2.1.1 Create users

e/pop offers a unique user creation method which reduces the overall e/pop administration. With its
unique auto user creation method, administrators simply distribute e/pop to the end user and configure
them to connect to the e/pop server. When the user starts e/pop the e/pop server automatically creates
the account for that user. WiredRed also offers the manual method for creating accounts. Although this
method is more time consuming, it is beneficial for organizations who intend to offer e/pop as an
Extranet communications tool.

There are 2 options for creating accounts on the e/pop server.

· Create e/pop accounts automatically

When a user starts e/pop for the first time, e/pop generates a UID (Unique Identifier) for the user and
stores it in the MyIdentity files which is located in the same directory as e/pop. Once the UID is created,
the clients sends the information to the e/pop server who searches the user database (TDUser) for the
matching UID. If the UID does not exist, the server auto creates a new account. If the UID exist, the
server updates the user's status and relays the status to other users running e/pop clients.

* The image below shows a users that was created automatically.

· Create accounts manually
Creating e/pop accounts manually is ideal when an organization want to use e/pop for secure Extranet
communications. Each e/pop account will have a login name and password which is given to the
Extranet user. The e/pop accounts can be tied to the corporate directory only if the user authenticates
into the corporate directory. The identity option is controlled via the identity section in the e/pop Control
Panel program.

* The image below shows a users that was created manually.

4.2.1.2 Delete users

You can delete users from e/pop by removing them from e/pop console. After you delete a user, all
pending messages for that users will become orphaned and will be purged after the default expiration
time.

Deleting Users

Below are the steps to delete a user or a group of users:

Step 1. Set the focus on a user/s
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Step 2. Right-click and select Delete User

4.2.1.3 Editing users

This features is designed for administrators to modify the properties for an e/pop account. If the e/pop
account in question was created using the auto create method, then the only option you can modify is
the Profile settings. If the e/pop account was created manually, all the other options can be modified.

Account tab
Account
This is the user's login name

Password
Password information the login name

Require password change at next logon
When enabled users must change their password after they login successfully

Profile tab

The profile option determine which profile a user belong to after connecting to the e/pop server
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Other tab

The Other tab indicates the type of e/pop client the user uses.

4.2.2 Working with groups

4.2.2.1 Working with groups

This topic describes using the grouping features of the e/pop server which is managed through the
System Console menu. While e/pop users can still individually access grouping, the e/pop server
administrator can also centrally control and manage groups. e/pop's grouping is not restricted to
single groups, but instead can be organized by locations and departments under sophisticated tree
structures.
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What is Grouping?

e/pop uses a hierarchical tree organizational structure for grouping.  e/pop can organize users under
multiple tree objects at any level.  This makes it possible to organize users by location, department
and even multi-departmental.  Users can also appear under various objects at different positions in
the directory tree.  This makes organizational structure grouping virtually limitless.

Group management is both centralized and de-centralized in the e/pop architecture.  Network
managers can use the e/pop management tools to organize users under various structures in the
directory.  These structures can be presented to users and can be centrally controlled using e/pop
profiles.  Group management is also decentralized, by allowing groups of users to organize
themselves without the intervention of the network manager, using the automated workgroup creation
feature available in the e/pop client.

Using the existing directory architecture of the network is a feature that is useful to e/pop's operation.
Network managers can choose to have Novell NetWare NDS and NT/2000 Domain objects used as
user and group objects within the real-time communication architecture.  This provides flexibility to
the existing organization structure as it is extended to the communication system of e/pop.

Note: e/pop groups cannot be used to control the features or rights within e/pop. You must use the
e/pop Control Panel if you want to manage or control e/pop features.

4.2.2.2 Creating groups

There are two groups types available in e/pop, 'Root group' and 'Sub groups'. A root group is created
by clicking the 'Add Root Group' button. To create a sub group, select the top level group and click the
'Add Group' button.

Note: You can create an unlimited number of e/pop group needed in e/pop.

4.2.2.3 Deleting groups

You can delete a single or multiple groups in e/pop by first selecting the group/s in the list and then
pressing the Delete Group button on the toolbar.
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4.2.2.4 Editing groups

You can edit the following properties of an e/pop group.

1. The name - You can rename an e/pop group by selecting the group and then clicking the Rename
button on the toolbar.

2. Group membership
Add users - You add users to a group by using the drap and drop method.
Deleteing users - You can delete users from a group by expanding the group, selecting the

user/s in question and then clicking the Delete User icon on the toolbar.

3. You can adjust the hierarchy position of a group in the directory by using the drag and drop method.
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4.3 Control your Directory view using Profiles

4.3.1 Overview - Profiles

e/pop 'Profiles' is design to limit the presentation of users in the e/pop directory. By default there are
no 'Profiles' assign to users. This means e/pop users can see all users when they first connect to the
e/pop server. If an organization wants to restrict a users's directory view, they must use a Profile with
limited number of users in it and assign it to user or users. You can think of Profiles as a buddy list
that is managed on the server.

For example, a typical organization might have an Accounting and Sales department.  The e/pop
system administrator chooses to limit the users and groups that are accessible by users in these
respective departments by creating a profile for each department.  The first profile is called
'Accounting' and the second profile is called 'Sales.'

For the Accounting users, the administrator drags and drops any user or group objects into the profile
window that he wants into the 'Accounting' profile.  The administrator then assigns the profile
'Accounting' to the e/pop users within the Accounting department.  Immediately the list of users and
groups seen by the Accounting e/pop users is limited to the users and groups that have been
included in the profile. Silimar procedure is repeated for the Sales Profile.

The e/pop system administrator will manage these profiles to include new objects as they become
available for the appropriate department.  By adding e/pop server groups, NDS groups, NT/2000
domain groups or other network groups to the profile, any new users appearing under these objects
will automatically be visible to any users assigned to the profile.

Tip: If you add a user from an e/pop, ADS, NT Domain or NDS group into a profile, the top level
object will appear in the Profile. It is important to note that this does not represent the entire group. It
only represents the users in that group. If you see a + symbol next to the group object, this means
only user objects directly under the group will appear in the e/pop Directory. If you want all group
members to appear under the group, simply drag and drop the group into the Profile and all users
under that group will appear in the Directory. This also forces the group members to be dynamic.

Creating a Profile

Adding Users and Groups to a Profile

Deleting objects from a Profile

Apply a Profile to users

4.3.2 Creating a Profile

To create a Profile simply click the Profiles icon on the side bar menu and then click the Add Profile
button on the toolbar.

Steps to create a Profile.
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List of Profiles.

4.3.3 Adding obects to a Profile

After you create a Profile you can add users or group to a profile using the following method

Step 1. Select a user or group of users.

Step 2. Drag and drop the user or group into the profile.

Note: Adding a group to a profile will include all current and future users under that group into the
selected profile.
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4.3.4 Deleting objects from a Profile

The information below explains the steps for deleting an object from a Profile.

Step 1. Select a Profile from the drop down menu

Step 2. Select the objects in the Profile

Step 3. Press the  Delete  button on the keyboard
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4.3.5 Manually apply a Profile to users

After you create a Profile you can manually assign it to a user or users by following the steps below.

Adding users to a Profile manually

Step 1. Select a user in the console

Step 2. Right click and select 'Set Profile'

Step 3. Select a Profile from the pull down menu

4.3.6 Automatically apply a Profile to users

You can also assign a Profile to account when it is first created on the e/pop server. This option is done
through the Server Settings menu under the Users tab.

When to use this feature: Since there is no way for an administrator to know exactly when a account
is created on the server, this feature will immediately filter a user's of the e/pop Directory.

How to use this feature: You can create a Profile that contains only e/pop administrators (i.e. a profile
called 'New users') and set it to be the default profile for all new accounts created in e/pop. In the
image below, the 'New Users' profile will be assigned to new users and the e/pop server will also notify
the administrator after the new account is created.
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4.4 Using Pipes if you have multiple e/pop servers

4.4.1 Using Pipes

Pipes are used to connect e/pop servers together thereby creating a virtual real-time connections
between servers. The goal for Pipes is to

1. Load balance users across multiple e/pop servers

2. Connect e/pop servers located across different physical locations

3. Reduce the amount of e/pop traffic that traverses across a WAN link

Pipes can also be used to extend communications in a B2B environment.  Because pipes leverage
the security policy of your e/pop server, you can ensure that your communications is secure even if
you connect two different organizations together over a public network (example: the Internet).

Because pipes tunnel all traffic between various e/pop locations, they are suitable for routing
communications over virtually any TCP/IP connection even through firewalls, Network Address
Translation Devices (NATs) and other type of gateways.

e/pop uses a channel mechanism efficiently designed to insure data is not transmitted more than
once across a pipe once when information is directed to a channel. e/pop provides a scalable solution
with it's real-time routing engine. The routing engine handles the internal management status, or
presence, for the e/pop user, channel management and data pipe flow.  Users connect directly to a
real-time routing server that connects to each other over virtual pipes.

An example of using Pipes
To better describe the functionality of Pipes, we will use a real world example where a company has 2
offices, one located in Los Angeles and the other located in New York. The two offices are connected
together over a point to point T1 connection. The T1 connection is used for Domain controller
replication, email and shared Internet access. The company has decided to open a real-time
communication channel between their employees so as to improve communications and productivity.
However, the company is concerned about the bandwidth availability over the T1 and wants to ensure
the real-time communication does not consume more bandwidth then necessary. After much
research they choose e/pop as their real-time communication solution.

Since the offices are physically located in two locations, LA and NY, they installed an e/pop server in
both offices and users in each office connect to the e/pop server local to them. The next step is to
connect the e/pop servers together. This is done by creating a Pipes from one server to the next.
When the pipe is created, the destination server automatically creates a pipe back to the server who
created the pipe. Once the Pipes are created and active, the e/pop server synchronize the user list
thus creating a global user list in the e/pop system. From the end users perspective, the Directory
appears as a single structure and they have no idea there are actually two e/pop servers on their
network. Pipes will also reduce the amount of traffic across the T1 connection.

In the following scenario a user in the LA office sends and instant popup message to 25 users in the
New York office. The message goes to the e/pop server in the LA server once, who then relays the
message over the T1 link to the e/pop server in New York (once). The e/pop server in New York then
relays the message to the 25 users.

4.4.2 Server topology

There are two basic designs for connecting e/pop servers together.

1. Star
This design is implemented by assigning one of the e/pop servers as the master e/pop server
and creating a Pipe to each secondary server. The image below illustrates this design. This
design is recommended for companies with multiple remote offices connecting to a central office.
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2. Straight line
This design is for companies with multiple offices and no central hub office. In this design e/pop
servers connect to each other in series as illustrated in the diagram below.

In some environments it may be neccesary to combine the designs so it adapts to a coporate
network. In the design below multiple Star configurations connect together because the company has
two major data center that are connected over a dedicated poin-to-point T1 connection.
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Pipes are created on one server (the source) and connect directly to another server (the destination).
The TCP/IP connection is originated at the source server, and is received on the destination server.
It is not necessary to create a pipe on both servers to connect them together.  Because pipes are bi-
directional, it is only necessary to create a pipe on one server.

The destination server will automatically accept the pipe connection provided it is authorized.  By
default, all pipe connections are authorized.  To require connecting pipes to have an account and
password you must enable the feature 'Always require system accounts for pipes' in the
destination server's settings and create a system account on the destination server.  The account and
password must be included with the source server's pipe.

Pipes can be created in a variety of patterns to connect your various e/pop servers together
throughout an organization, around the world.  Pipes are intelligent real-time routing devices.  They
can automatically re-route your real-time traffic in the event of a physical network failure or outage.
You can create multiple pipes on any server to multiple destination servers.  Therefore it is possible
to configure your real-time routing in a variety of network design topologies.  The layout of your pipes
in your organization should be based on the infrastructure design of your WAN and VLANs to limit
connections over slower WAN links based upon the TCP/IP sub-networking of your network.

4.4.3 Benefits of Pipes

There are several benefits for using Pipes. The benefits are,

1. It reduces the amount of e/pop traffic over a WAN connection.

2. Load balance users across multiple servers but maintains a unified user list.

3. Offers a secure communication channel for companies with multiple offices (even over the
Internet)

4. Offers a secure communication channel with business partners or customers.

4.4.4 Pipes and the e/pop user list

When e/pop servers connect together over Pipes, they synchronize their user list to form one global
user list in the e/pop Directory. The sychronization feature is completely dynamic and uses high
compression to reduce the amount of traffic placed on the network. This is true even if there are
thousands of users using e/pop.
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4.4.5 Creating a Pipe

If you have multiple e/pop servers and need to connect them together, you must create a Pipe between
the servers. Below are the steps for creating a Pipe.

Creating a Pipe ( six step process)

Step 1. Select the e/pop server to host the Pipes. This is preferably the computer with more speed and
RAM.

Step 2. Start the e/pop Console

Step 3. Connect the Console to the e/pop server

Step 4. When the Console connects to the e/pop server, it will default to the Pipe view

Step 5. Create a Pipe by clicking on the Add Pipe button on the toolbar and complete the information
in the Pipe window. Click on OK when complete.
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Step 6. Enable the Pipe by clicking on the Enable button

Note: When the Pipe is active, the servers will sychronize their user list. The Server Viewer displays
the initial activity of the Pipes when the Pipe is enabled.
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4.4.6 Pipe security

Any information sent over Pipes is encrypted prior to being transmitted. By default e/pop uses RC4
encryption but you can increase the level of encryption through the Server Settings menu.
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As an added level of security you can set the destination e/pop server to only accept incoming Pipes
with a valid system account. Note: The system account must be created on the destination server and
the information is then inserted in the source server.

Step1. First, create the necessary account of the destination computer
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Step 2. On the source server, modify the pipe properties so the pipe uses a system account when
connecting to the destination server.
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4.4.7 Viewing users after a Pipe is 'Enabled'

After a Pipes is created and enabled, the e/pop server will synchronize their users with other e/pop
servers. When the synchronization process is complete, the users are identified as either 'Local' users
or 'Remote' users. By default, 'Remote' users are not visible in the Console. To view 'Remote users,
you must enable the 'Remote' user option in the 'Users' view.

The image below shows 'Local' users only

The image below shows 'Local' and 'Remote' users
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4.4.8 Sychronizing the user list

User account associated with Pipes
Each e/pop account sent over a Pipe is associated with that Pipe. When an account is deleted on the
server hosting the account, the host server will instruct the remote servers to delete the associated
remote user from their list. This automated process only occurs when Pipes are active. If an account is
deleted when the Pipe is disable, the deprovisioning process will not sychronize across servers. If this
happens, you must connect the Console to the remote servers and delete the remote user account in
question from the 'Remote Users' list. If there are multiple servers connected over Pipes, you must
clean the unwanted user on all the servers. As a rule of thumb, avoid deleting users when Pipes are
disabled.

If for any reason a Pipe is deleted after e/pop servers synchronize their user list, the remote accounts
on all the servers will become orphan because the assoicated Pipes no longer exist. When this
happens, you must delete all the remote users that was associated with that Pipe. To simply this
process you should switch the 'Users' view to display only 'Remote users' and then sort the users by
their IP address. This will give you a good idea of which user to delete.

Groups
e/pop groups are not replicated across servers. If you need to have an e/pop group with members from
different e/pop servers, you must create the group with the exact match name on each e/pop server.
When the process is complete, the group members will merge and be presented in the e/pop Directory
as one group.

4.4.9 Measuring traffic over Pipes

After a Pipe is enabled, you can measure all the traffic sent over the Pipe. Simply select the Pipe and
click the 'Graph' icon on the toolbar.
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4.4.10 Tips for using Pipes

Tip 1. e/pop Pipes was designed to establish a real-time virtual connection between e/pop servers.
The view in the e/pop Directory is dynamic and will change as users connect and disconnect from
e/pop servers.
The view in the Console is not dynamic. To view an updated list of users in the Console, you must
press the F5 key on the keyboard or select the 'Refresh' option from the 'File > Refresh' option from
the menu.

Tip 2. Ensure to remove remote users from all servers connected over Pipes if you delete a Pipe.

Tip 3. Use system accounts if e/pop servers connect together directly over the Internet.
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4.5 Uninstalling e/pop

4.5.1 Uninstalling e/pop

Uninstall the e/pop client
You can uninstall e/pop using the Add/Remove feature in Windows. This uninstall option is only
available if you install e/pop using the setup program. If you installed e/pop other then the setup
program, you must must manually delete the entire e/pop folder and the all the registry keys
hkey_current_user\software\wiredred\epop.

Uninstall the e/pop server
Uninstalling the e/pop server removes all data files from the computer. If you wish to retain any
information related to e/pop prior to uninstalling it, you must make a backup copy of all the TD*.* files
in the e/pop server folder.
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5 Securing e/pop

5.1 Overview of e/pop security

There are three primary security features available in e/pop.

First, you can secure in coming connections to the e/pop server to authorize users only. (Control
Panel & Console)
Second, encrypt all e/pop information on the network. (Console)
Third,  control user access to specific features in the client. (Control Panel)
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5.2 Securing access to e/pop

5.2.1 Clients connecting to the server

The e/pop server will accept incoming client connections from any user by default. To secure incoming
connections to authorized users only, the e/pop client and server must be set to use the Global Code
option. Anyone using an e/pop client with a different code or a client with no global code will not
connect to the e/pop server.

5.2.2 Secure access to the server via the console

The e/pop Console is the primary utility used to administer the e/pop server. By default the server will
allow any user using the Console to connect as long as the user knows the IP address of the server.
Although this implementation reduces the learning curve for a new e/pop administrator, it should be
change once the administrator learns the basic workings of the Console. To secure the server from
unauthorize Console access, the administrator must use the steps below (2 steps total)

Step 1. Create a system account with Console rights.

a. Click the System Accoun button on the Console toolbar

b. Click on Add to create a new system account

c. Enter the information for the System Account

d. Enable Console access for this account
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Step 2. Enable the option that requires a system account for Console access

a. Click on Server Settings menu

b. Click the Security Policy tab

c. Enter the Console options
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5.2.3 Secure connection for incoming Pipes

Connecting e/pop servers together is another method to gain access into the e/pop system. By default
the e/pop server will accept connections from any incoming Pipe. To secure your e/pop system from
unauthorize Pipe connections, you must enable the appropreiate security options. The steps below
describe the steps for enabling these options.

Step 1. Create a system account for use by incoming Pipes.
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Step 2. Enable the option that requires an incoming to Pipe to have an authorize system account.
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5.3 Encrypting e/pop information

5.3.1 Encrypting e/pop information

e/pop's real-time engine uses a combination of security protocols. The server security policy defines
the level of security required by all connecting e/pop clients and pipes.

Note: The e/pop server's default security implementation is RC4 encryption to secure communication
between users, servers and the data flowing over pipes.

Organizations can selectively enable additional security controls and implement RSA 512 bit to
communicate with users and other servers over pipes.

RSA encryption is combined with RC4, DES or AES encryption to secure the connection and
maximize performance.  RSA is used to authenticate connections and secure communications while
exchanging passwords and security keys.

e/pop offers the following encryption options:

· RC4 encryption

· RSA encryption with RC4

· RSA encryption with DES

· RSA encryption with Triple-DES

· RSA encryption with AES

RC4 provides basic, secure and fast communications over all connections.  RSA  512 bit is combined
with DES or Triple-DES to enhance security and RSA with AES provides the highest level of
encryption and security.

5.3.2 RSA Security

RSA is used to authenticate connections and establish secure communications.  It provides a high
level of security for mission-critical business information traveling over unsecured networks.  We
recommend using RSA when either the type of data, or the medium the data is being sent over is
sensitive.  We recommend using RSA for public networks such as the Internet.

Enabling RSA encryption will require all connections to create digital certificates.  The digital
certificates are unique to each user and stored under the name MyCertificate.* in each individual
user's e/pop directory.

The initial digital certificate creation process can take a while. With this in mind, consider creating a
common certificate with the e/pop client before distributing the e/pop client or only use RSA level
security when the implementation requires it.
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5.3.3 Using RSA Security on the e/pop Server

Using RSA Security on the e/pop Server

Encrypt by enabling RSA on the server, all users and servers connecting over pipes will create digital
certificates.  To enable RSA and subsequently automatically create digital certificates:

1. Start the e/pop Server Console.

2. Connect to the desired server.

3. Click the Server Settings  button.

4. Select the Security Policy tab.

5. Check the RSA encryption w/RC4, click OK, you will receive the 'Restart server' message.

6. To enable the security policy change, you must restart the e/pop server.  The server will create a
certificate unique to the server on the initial restart if you selected RSA security.  Future e/pop
console connections will also be secured using the server's security policy. The secure connection

icon  will appear at the bottom of the Server Console window indicating you have a secure
connection.

The following files are created on the server when RSA encryption is enabled.

· TDCertificate.DAT

· TDCertificate.IDX

· TDCertificate.BLB

* e/pop server creates a certificate when the option is first enabled.
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5.3.4 Using RSA Security on the e/pop Client

Using RSA Security on the e/pop Client

The e/pop server's security policy not only affects server console connections and pipes, but also
e/pop client connections.  Initial user connections to a server with a new security policy that includes
RSA will require the client to create a secure certificate.  You can create and distribute the
MyCertificate.* files with your e/pop distribution or they can be created automatically by the client.

The secure certificate creation message will appear on your screen during the initial certificate

creation.  This process is only performed once for each e/pop client. The secure connection icon 
will appear at the bottom of the e/pop Client window indicating you have a secure connection.

The following files are created when RSA is included in the server's security policy:

· MyCertificate.DAT

· MyCertificate.IDX

· MyCertificate.BLB



Securing e/pop

e/pop Admin Guide

121Control features in the client

5.4 Control features in the client

5.4.1 Control access to features

To control or restrict access to features within the e/pop client you must use the e/pop Control
Panel.The e/pop Control Panel is available with all e/pop clients and it resides in the folder where
e/pop was installed. The Control Panel utility is a unique configuration tool because it stores all the
configuration changes back in the e/pop client exectuable file. When the configuration is complete,
the e/pop administrator will have a custom e/pop client with all the changes embedded in the e/pop
executable file. The administrator simply distributes the custom e/pop executable to all users and the
entire process is complete.

Note: The Control Panel file is called epopcp.exe. When the customization is complete, you should
remove that file from all computers with e/pop.

The following table provides a brief description of the Feature Control Settings menu available in the
e/pop Control Panel.
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e/pop Control Panel
options

Description

General Display the splash screen and the tray icon.

Exit Display and control the ability to exit.

Restrictions Disable ability to access e/pop, dialogs, menus and functions

 Options Disable access to option controls as well as specific option pages

Workgroups Specify general preferences for workgroups and settings for default
workgroups

My Files  Specify location and paths for user personal files (history, message,
macros and shortcuts)

My Files (continued) Specify location of the mylocaitons files and user specific features to
enable

Status Specify default personal status message(s) and status related options

Features - Send Controls a users ability to send selected features

Features - Receive Controls a users ability to receive selected features

Confirmation Send Specify whether confirmations are required when sending to multiple
recipients as features

Confirmation Receive Specify whether receive confirmations are optional, required or
removed as features

Sounds Specify sounds for new messages and chat sessions

 Message Specify message preferences and default archive location for
messages

Message (continued) Specify message preferences

Chat Specify preferences for chat

Networks Disable specific directory objects from communications

Domain Preferences for NT Domain integration

Domain (continued) Perference for NT Domain objects in the directory

ADSI Perferences for ADSI integration

NDS Perferences for Novell NDS integration

GroupWise Perferences for Novell GroupWise integration

Identity Controls the visual identity of users in the e/pop directory

Directory Perferences for the e/pop directory/User list

Protocol Perferences for using specific protocols and TCP ports

Advanced Protocol Specific preferences for support protocols

Security Secures the e/pop executable and advanced messaging options
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6 Using Remote Administration

6.1 Remote Administration

This topic describes using the remote administration features of e/pop. The remote administration
features can run applications on remote computers on your network. You can also remotely control
tasks and processes, reboot or shut down computers.

Note: Access to these features can be restricted or removed from the e/pop application through use
of the e/pop control panel.

Starting Remote Administration

You can start Remote Administration in one of these ways:

1. Select the object(s) from the directory for the remote administration session.

2. Click the Admin button and then the Remote Admin icon in the left window.

3. Select Remote Admin from the Actions Menu.

4. Right-click a user in the Directory and select Remote Admin or press Ctrl A.

5. Double-click on a user in the Directory if Remote Admin has been set as the default feature (see
Options > Directory > Remote Admin from the e/pop client menu).

Closing Tasks or Processes

The Tasks feature of Remote Administration allows you to examine the active window tasks of one or
more computers remotely over the network.  Individual tasks can be isolated using the search filter.

Running Programs on Remote Computers

The Run feature of Remote Administration allows you to execute a command on remote computers
over the network immediately.  Use the Run feature of e/pop to execute a program, batch file, registry
merge, file association or other update throughout your network.  You can also run URL references
and any valid command line that works from the Start > Run feature of Windows.

Rebooting or Shutting Down Remote Computers

The Reboot feature of Remote Administration allows you to remotely power off, reboot or reset
computers across the network.
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6.2 Closing Tasks or Processes

To close tasks and processes on remote computers:

1. Click the Tasks tab if it is not displayed.

2. Click Search to display all window processes for the selected users.

3. Type in a search filter if needed.

4. Select the window processes to be closed.

5. Click Log Receipts  to receive a return receipt with a successful closing of a task.

6. Click Send to close the selected processes.
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6.3 Running Programs on Remote Computers

The Run feature of Remote Administration allows you to execute a command on remote computers
over the network immediately. Use the Run feature of e/pop to execute a program, batch file, registry
merge, file association or other update throughout your network. You can also run URL references and
any valid command line that works from the Start > Run feature of Windows.

To run programs on remote computers:

1. Click the Run tab.

2. Type in the name of the program, folder, or document you want to run.

3. Click Log Receipts to receive a return receipt with a successful run.

4. Click Send.
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6.4 Rebooting or Shutting Down Remote Computers

Steps to reboot or shut down remote computers

1. Click the Reboot tab.

2. Select either Shutdown or Restart.

3. Include the Power Off option in conjunction with Shutdown to turn the
power off on machines with Advanced Power Management capabilities.

4. The Force option can be used to close applications that would normally
pause the shutdown of Windows, such as saving a document before exiting.

5. Click Log Receipts  to receive a return receipt with a successful reboot.

6. Click Send.
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